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MICROSOFT WORD 2007 

Q1: Microsoft Word 2007 Èया है? 

A: Microsoft Word 2007 is a word processing software that allows users to 

create and edit documents. 

A: Microsoft Word 2007 एक शÞद Ĥसèंकरण सॉÝटवेयर है जो 

उपयोगकता[ओं को दèतावेज़ बनाने और संपाǑदत करने कȧ अनुमित देता है। 

  Ribbon Interface: 

 Replaces traditional menus with tabs that organize commands and 

tools. 

  New File Format (.docx): 

 Improved file management and compatibility with other applications. 

  SmartArt Graphics: 

 Enables users to create diagrams and visual representations easily. 

  Templates: 

 Pre-designed formats for different document types (letters, resumes, 

reports). 

  Formatting Options: 

 Extensive text and paragraph formatting tools, including styles, fonts, 

and colors. 
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  Mail Merge: 

 Create personalized documents using data from a database or 

spreadsheet. 

  Spell Check and Grammar Check: 

 Real-time error detection and suggestions for correction. 

  Tables and Charts: 

 Easy insertion and formatting of tables and charts for data 

organization. 

  Hyperlinks: 

 Create clickable links to websites or other documents. 

अितǐरƠ मुÉय ǒवशेषताएँ: 

1. दèतावेज़ ĤाǾपण: 

पाठ, अनÍुछेद और पƵृɉ के िलए åयापक ĤाǾपण ǒवकãप Ĥदान 

करता है, ǔजसमɅ फ़ॉÛट, आकार, रंग और संरेखण शािमल हɇ। 

2. वत[नी और åयाकरण जांच: 

उपयोगकता[ओं को वाèतǒवक समय मɅ वत[नी और åयाकरण कȧ 

गलितयɉ को ठȤक करने मɅ मदद करने के िलए अंतिन[िम[त उपकरण। 
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3. मेल मज[: 

उपयोगकता[ओं को åयǒƠगत त×वɉ (जैसे नाम और पते) वाले कई 

दèतावेज़ (जैसे पğ) बनाने कȧ अनुमित देता है। 

4. तािलका िनमा[ण: 

डेटा के बेहतर संगठन के िलए उपयोगकता[ आसानी से तािलकाएँ 

डाल सकते हɇ। 

5. शैिलयाँ और ǒवषय: 

दèतावेज़ के िनरंतर ĤाǾपण के िलए शैिलयɉ और ǒवषयɉ का ×वǐरत 

अनĤुयोग। 

6. हाइपरिलंक: 

उपयोगकता[ओं को वेबसाइटɉ या अÛय दèतावेज़ɉ के िलए ǔÈलक 

करने योÊय िलंक बनाने कȧ अनुमित देता है। 

7. ǒĤंǑटंग ǒवकãप: 

ǒĤंट पूवा[वलोकन और ǒĤंट लेआउट ǒवकãपɉ सǑहत उÛनत ǒĤंǑटंग 

सǒुवधाएँ। 

 

 

Q2: What are the main features of Word 2007? 
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Q2: Word 2007 कȧ मुÉय ǒवशेषताएँ Èया हɇ? 

A: Key features include the Ribbon interface, .docx file format, SmartArt, 

improved collaboration, and various templates. 

A: मÉुय ǒवशेषताओ ंमɅ ǐरबन इंटरफेस, .docx फ़ाइल ĤाǾप, èमाट[आट[, 

बेहतर सहयोग, और ǒविभÛन टेàपलेट शािमल हɇ। 

 

Q3: What is the purpose of the Ribbon in Word 2007? 

Q3: Word 2007 मɅ ǐरबन का उƧेæय Èया है? 

A: The Ribbon organizes commands into tabs for easy access to tools and 

features. 

A: ǐरबन उपकरणɉ और सǒुवधाओं तक आसान पहँुच के िलए आदेशɉ को 

टैब मɅ åयवǔèथत करता है। 

 

Q4: How can you save a document in Word 2007? 

Q4: आप Word 2007 मɅ दèतावेज़ को कैसे सहेज सकते हɇ? 

A: Click on the Office button, then select "Save" or "Save As" to save 

your document. 

A: ऑǑफस बटन पर ǔÈलक करɅ, Ǒफर अपने दèतावेज़ को सहेजने के िलए 

"सहेजɅ" या "सहेजɅ जैसे" का चयन करɅ। 
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Q5: What file format does Word 2007 use by default? 

Q5: Word 2007 Ǒडफ़ॉãट Ǿप से Ǒकस फ़ाइल ĤाǾप का उपयोग करता है? 

A: Word 2007 uses the .docx file format by default. 

A: Word 2007 Ǒडफ़ॉãट Ǿप से .docx फ़ाइल ĤाǾप का उपयोग करता है। 

 

Q6: Can you insert images in Word 2007? 

Q6: Èया आप Word 2007 मɅ छǒवयाँ डाल सकते हɇ? 

A: Yes, you can insert images by clicking on the "Insert" tab and selecting 

"Picture." 

A: हाँ, आप "सǔàमिलत करɅ" टैब पर ǔÈलक करके और "िचğ" का चयन 

करके छǒवयाँ डाल सकते हɇ। 

Q3: How can you save a document in Word 2007? 

Q3: आप Word 2007 मɅ दèतावेज़ को कैसे सहेज सकते हɇ? 

A: Click on the Office Button and select "Save" or "Save As" to save your 

document. 

A: ऑǑफस बटन पर ǔÈलक करɅ और अपने दèतावेज़ को सहेजने के िलए 

"सहेजɅ" या "सहेजɅ जैसे" का चयन करɅ। 
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Q4: What are templates in Word 2007? 

Q4: Word 2007 मɅ टेàपलेÒस Èया हɇ? 

A: Templates are pre-designed document formats that help users create 

consistent documents easily. 

A: टेàपलेÒस पूव[-िनधा[ǐरत दèतावेज़ ĤाǾप होते हɇ जो उपयोगकता[ओं को 

आसानी से सुसंगत दèतावेज़ बनाने मɅ मदद करते हɇ। 

 

Q5: What is Mail Merge? 

Q5: मेल मज[ Èया है? 

A: Mail Merge is a feature that allows users to create personalized letters 

or documents using data from a database. 

A: मेल मज[ एक ǒवशेषता है जो उपयोगकता[ओं को डेटाबेस से डेटा का 

उपयोग करके åयǒƠगत पğ या दèतावेज़ बनाने कȧ अनुमित देती है। 

 

Q6: How do you insert a table in Word 2007? 

Q6: आप Word 2007 मɅ तािलका कैसे डाल सकते हɇ? 

A: Click on the "Insert" tab and select "Table" to create a new table. 



vkb;s lh[ksa--- dEI;wVj vkSj bafXy'k & IICE ,d csgrjhu laLFkk tgka feyrh gS csgrj f'k{kk 
 

 
Founder/Manager: Jamal Ahmad Khan, Mobile No.: 9935404262 
Email: iicepatranga2@gmail.com       (Page No. 9) 

A: "सǔàमिलत करɅ" टैब पर ǔÈलक करɅ और एक नई तािलका बनाने के 

िलए "तािलका" का चयन करɅ। 

 

Q7: How can you check spelling and grammar? 

Q7: आप वत[नी और åयाकरण कȧ जांच कैसे कर सकते हɇ? 

A: Click on the "Review" tab and select "Spelling & Grammar" to run the 

checks. 

A: "समी¢ा" टैब पर ǔÈलक करɅ और जांच करने के िलए "वत[नी और 

åयाकरण" का चयन करɅ। 

Q.8 What are the uses of "FIND" and "REPLACE" option? 

 "FIND" vkSj "REPLACE" dek.M dk iz;ksx fyf[k,A 

Ans. "Find" and "Replace" Option in MS Word 

The "Find" and "Replace" features in Microsoft Word are essential tools 

for quickly locating and changing text within a document. These options 

save time by automating the search for specific words or phrases and 

replacing them if needed. 

1. Find Option 
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 Purpose: The "Find" tool is used to search for a particular word, 

phrase, or character in a document. It's useful when you need to 

navigate a long document or find specific information quickly. 

 How to Use: 

1. Open the document. 

2. Press Ctrl + F or go to the Home tab and click on Find in 

the Editing group. 

3. A navigation pane will open on the left, where you can type the 

word or phrase you want to search for. 

4. Word will highlight all instances of the search term in the 

document. 

2. Replace Option 

 Purpose: The "Replace" tool not only allows you to find a specific 

word or phrase but also replace it with something else. This is helpful 

when you need to correct repetitive errors or change terminology 

throughout the document. 

 How to Use: 

1. Open the document. 

2. Press Ctrl + H or go to the Home tab and click on Replace 

in the Editing group. 

3. In the dialog box, enter the word or phrase you want to find in 

the Find what field. 

4. Enter the new word or phrase in the Replace with field. 

5. Click on Replace to replace one instance or Replace All to 

replace all instances at once. 

Advanced Options: 
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 You can also use advanced options like matching case (upper/lower 

case), finding whole words only, or using wildcards for more 

complex searches. 

 

"Find" और "Replace" ǒवकãप (MS Word) 

MS Word मɅ "Find" और "Replace" सǒुवधाएँ दèतावेज़ मɅ टेÈèट को 

जãदȣ से खोजने और बदलने के िलए अ×यंत मह×वपूण[ उपकरण हɇ। ये 

ǒवकãप समय बचाते हɇ और आपको दèतावेज़ मɅ Ǒकसी ǒवशेष शÞद या 

वाÈयांश को खोजने और उसे बदलने कȧ सुǒवधा Ĥदान करते हɇ। 

1. Find ǒवकãप 

 उƧेæय: "Find" टूल का उपयोग दèतावेज़ मɅ Ǒकसी ǒवशेष शÞद, 

वाÈयांश, या अ¢र को खोजने के िलए Ǒकया जाता है। यह तब 

उपयोगी होता है जब आपको बड़े दèतावेज़ मɅ तेजी से नेǒवगेट करना 

हो या कोई ǒवशेष जानकारȣ ढँूढनी हो। 

 कैसे उपयोग करɅ: 

1. दèतावेज़ खोलɅ। 

2. Ctrl + F दबाएँ या Home टैब मɅ जाकर Find पर ǔÈलक करɅ 

(यह Editing समूह मɅ होता है)। 
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3. बाɃ ओर एक नेǒवगेशन पैन खुल जाएगा, जहाँ आप वह शÞद 

या वाÈयांश टाइप कर सकते हɇ ǔजसे आप खोजना चाहते हɇ। 

4. Word उस शÞद के सभी उदाहरणɉ को दèतावेज़ मɅ हाइलाइट 

कर देगा। 

2. Replace ǒवकãप 

 उƧेæय: "Replace" टूल न केवल आपको Ǒकसी ǒवशेष शÞद या 

वाÈयांश को खोजने देता है, बǔãक उसे Ǒकसी और से बदलने कȧ भी 

सǒुवधा देता है। यह तब उपयोगी होता है जब आपको Ǒकसी गलती 

को बार-बार ठȤक करना हो या पूरे दèतावेज़ मɅ शÞदɉ को बदलना 

हो। 

 कैसे उपयोग करɅ: 

1. दèतावेज़ खोलɅ। 

2. Ctrl + H दबाएँ या Home टैब मɅ जाकर Replace पर ǔÈलक 

करɅ (यह Editing समूह मɅ होता है)। 

3. संवाद बॉÈस मɅ, Find what फ़ȧãड मɅ वह शÞद या वाÈयांश दज[ 

करɅ ǔजसे आप खोजना चाहते हɇ। 

4. Replace with फ़ȧãड मɅ नया शÞद या वाÈयांश दज[ करɅ ǔजसे 

आप पुराने शÞद के èथान पर रखना चाहते हɇ। 
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5. Replace पर ǔÈलक करɅ ताǑक केवल एक उदाहरण बदला जाए 

या Replace All पर ǔÈलक करɅ ताǑक सभी उदाहरण बदले जाएँ। 

उÛनत ǒवकãप: 

 आप उÛनत ǒवकãपɉ का भी उपयोग कर सकते हɇ, जैसे Ǒक केस 

िमलाना (बड़े/छोटे अ¢र), केवल पूरे शÞद ढँूढना, या अिधक जǑटल 

खोजɉ के िलए वाइãडकाÔस[ का उपयोग करना। 

 

 

Q8: What is the function of the Office Button? 

Q8: ऑǑफस बटन का काय[ Èया है? 

A: The Office Button provides access to file-related tasks like opening, 

saving, and printing documents. 

A: ऑǑफस बटन फ़ाइल से संबंिधत कायɟ जैसे दèतावेज़ खोलने, सहेजने 

और ǒĤंट करने के िलए पहँुच Ĥदान करता है। 

 

Q9: How do you create a hyperlink in Word 2007? 
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Q9: आप Word 2007 मɅ हाइपरिलंक कैसे बना सकते हɇ? 

A: Highlight the text, right-click, select "Hyperlink," and enter the URL to 

link. 

A: पाठ को हाइलाइट करɅ, राइट-ǔÈलक करɅ, "हाइपरिलंक" का चयन करɅ, 

और िलंक करने के िलए URL दज[ करɅ। 

 

Q10: Can you customize the Ribbon in Word 2007? 

Q10: Èया आप Word 2007 मɅ ǐरबन को कèटमाइज़ कर सकते हɇ? 

A: Yes, you can add or remove tabs and commands in the Ribbon to suit 

your needs. 

A: हाँ, आप अपनी आवæयकताओ ंके अनुसार ǐरबन मɅ टैब और आदेश 

जोड़ या हटा सकते हɇ। 

Microsoft Word 2007 Detailed Overview / माइĐोसॉÝट वड[ 2007 का 

ǒवèततृ अवलोकन 

1. User Interface / उपयोगकता[ इंटरफेस: 

 Ribbon: The most significant change in Word 2007 is the Ribbon 

interface, which organizes tools and commands into tabs for easier 

access. Each tab contains groups of related commands. 

(ǐरबन: Word 2007 मɅ सबसे बड़ा पǐरवत[न ǐरबन इंटरफेस है, जो 

उपकरणɉ और आदेशɉ को टैब मɅ åयवǔèथत करता है, ǔजससे उÛहɅ 
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एÈसेस करना आसान होता है। Ĥ×येक टैब मɅ संबंिधत आदेशɉ के 

समूह होते हɇ।) 

 Quick Access Toolbar: A customizable toolbar that provides quick 

access to commonly used commands like Save, Undo, and Redo. 

(ǔÈवक एÈसेस टूलबार: एक कèटमाइज़ेबल टूलबार जो सामाÛय Ǿप 

से उपयोग Ǒकए जाने वाले आदेशɉ जैसे सहेजɅ, पूव[वत करɅ, और पुनः 

करɅ तक ×वǐरत पहँुच Ĥदान करता है।) 

2. Document Creation and Editing / दèतावेज़ िनमा[ण और संपादन: 

 New Document Templates: Users can choose from various 

templates for letters, resumes, reports, and more, helping to 

streamline document creation. 

(नए दèतावेज़ टेàपलेÒस: उपयोगकता[ पğɉ, ǐरóयूम, ǐरपोटɟ और 

अिधक के िलए ǒविभÛन टेàपलेÒस मɅ से चुन सकते हɇ, ǔजससे 

दèतावेज़ िनमा[ण को सरल बनाया जा सकता है।) 

 Editing Tools: Includes cut, copy, paste, and format painter to easily 

replicate formatting from one part of the document to another. 

(संपादन उपकरण: इसमɅ काटɅ, कॉपी करɅ, पेèट करɅ, और फ़ॉमȶट पɅटर 

शािमल हɇ, जो दèतावेज़ के एक भाग से दसूरे भाग मɅ ĤाǾपण को 

आसानी से दोहराने कȧ अनुमित देता है।) 

 Find and Replace: An efficient way to search for specific text and 

replace it throughout the document. 
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(खोजɅ और बदलɅ: ǒविशƴ पाठ को खोजने और दèतावेज़ मɅ इसे 

बदलने का एक कुशल तरȣका।) 

3. Formatting and Styling / ĤाǾपण और शैली: 

 Font Styles: Extensive options for font types, sizes, and colors, as 

well as bold, italic, underline, and strikethrough effects. 

(फ़ॉÛट शैिलयाँ: फ़ॉÛट Ĥकारɉ, आकारɉ, और रंगɉ के िलए åयापक 

ǒवकãप, साथ हȣ बोãड, इटैिलक, अंडरलाइन, और èĚाइकĠू Ĥभाव।) 

 Paragraph Formatting: Users can adjust line spacing, indentation, 

and alignment (left, center, right, justify). 

(अनÍुछेद ĤाǾपण: उपयोगकता[ रेखा कȧ èपेिसंग, इंडɅटेशन, और 

संरेखण (बाए,ं कɅ ġ, दाएं, सहȣ) समायोǔजत कर सकते हɇ।) 

 Styles Gallery: Predefined styles that allow users to apply consistent 

formatting quickly across headings, body text, and other document 

elements. 

(शैिलयɉ कȧ गैलरȣ: पूव[-िनधा[ǐरत शैिलयाँ जो उपयोगकता[ओं को 

शीष[कɉ, मुÉय पाठ, और अÛय दèतावेज़ त×वɉ मɅ तेजी से सुसंगत 

ĤाǾपण लागू करने कȧ अनुमित देती हɇ।) 

4. Graphics and Multimedia / ĒाǑफÈस और मãटȣमीǑडया: 

 Inserting Images: Users can insert pictures from files or online 

sources, along with options to format images (resize, crop, add 

borders). 
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(िचğ डालना: उपयोगकता[ फ़ाइलɉ या ऑनलाइन İोतɉ से िचğ डाल 

सकते हɇ, साथ हȣ िचğɉ को ĤाǾǒपत करने के ǒवकãप (आकार 

बदलना, Đॉप करना, सीमा जोड़ना)।) 

 Shapes and SmartArt: Tools for inserting shapes and creating 

diagrams to visually represent ideas and processes. 

(आकृितयाँ और èमाट[आट[: आकृितयाँ डालने और ǒवचारɉ और 

ĤǑĐयाओ ंका Ǻæय Ĥितिनिध×व करने के िलए आरेख बनाने के 

उपकरण।) 

 WordArt: A feature that allows users to create stylized text with 

various effects and colors. 

(वड[आट[: एक ǒवशेषता जो उपयोगकता[ओं को ǒविभÛन Ĥभावɉ और 

रंगɉ के साथ èटाइिलश टेÈèट बनाने कȧ अनुमित देती है।) 

5. Collaboration and Review / सहयोग और समी¢ा: 

 Comments: Users can add comments to specific parts of the 

document for feedback or collaboration purposes. 

(ǑटÜपǔणयाँ: उपयोगकता[ दèतावेज़ के ǒविशƴ भागɉ मɅ ǑटÜपǔणयाँ 

जोड़ सकते हɇ फȧडबैक या सहयोग के उƧेæयɉ के िलए।) 

 Track Changes: Allows users to see modifications made to the 

document and accept or reject changes during the review process. 

(पǐरवत[नɉ को Ěैक करɅ: उपयोगकता[ओं को दèतावेज़ मɅ Ǒकए गए 
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पǐरवत[नɉ को देखने कȧ अनुमित देता है और समी¢ा ĤǑĐया के 

दौरान पǐरवत[नɉ को èवीकार या अèवीकार करɅ।) 

 Document Comparison: Users can compare two documents to 

identify differences, useful for collaborative projects. 

(दèतावेज़ तुलना: उपयोगकता[ दो दèतावेज़ɉ कȧ तुलना कर सकते हɇ 

ताǑक अंतर पहचाने जा सकɅ , जो सहयोगी पǐरयोजनाओ ंके िलए 

उपयोगी है।) 

6. Common Formula Functions 

Word supports several common functions for calculations. Here are the 

most frequently used ones: 

  SUM(): Adds a range of numbers. 

Example: =SUM(ABOVE) sums all numbers above the current cell. 

You can also specify a range like =SUM(A1:A5). 

  AVERAGE(): Calculates the average of a range of numbers. 

Example: =AVERAGE(ABOVE) finds the average of the numbers 

above. 

  MIN(): Finds the minimum value in a range of numbers. 

Example: =MIN(LEFT) finds the smallest number to the left. 

  MAX(): Finds the maximum value in a range of numbers. 
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  Example: =MAX(ABOVE) returns the largest number above the 

cell. 

How to Insert Formulas in MS Word 

1. Create a table. 

2. Place the cursor in the cell where you want the formula. 

3. Go to the Table Tools tab, click on the Layout tab. 

4. In the Data group, click on Formula. 

5. In the Formula dialog box, enter the desired formula and click OK. 

MS Word मɅ फामु[लɉ का उपयोग टेबãस मɅ गणना करने के िलए Ǒकया 

जा सकता है, जैसा Ǒक Excel मɅ Ǒकया जाता है। हालाँǑक, Word के फामु[ले 

Excel कȧ तुलना मɅ सरल होते हɇ, लेǑकन यह जोड़, घटाव, गुणा और औसत 

जैसी सामाÛय गणनाओ ंके िलए उपयोगी होते हɇ। यहाँ MS Word मɅ 

फामु[लɉ से संबंिधत मुÉय ǒबंद ुǑदए गए हɇ: 

2. Ĥचिलत फामु[ला फ़ंÈशंस 

Word कई सामाÛय गणना फ़ंÈशंस का समथ[न करता है। कुछ Ĥमुख 

फ़ंÈशंस िनàनिलǔखत हɇ: 

 SUM(): एक सीमा कȧ संÉयाओं को जोड़ता है। 

o उदाहरण: =SUM(ABOVE) वत[मान कोिशका के ऊपर कȧ सभी 

सÉंयाओं को जोड़ता है। 
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o आप Ǒकसी ǒवशेष रɅज को भी िनǑद[ƴ कर सकते हɇ जैसे 

=SUM(A1:A5)। 

 AVERAGE(): एक सीमा कȧ औसत गणना करता है। 

o उदाहरण: =AVERAGE(ABOVE) ऊपर कȧ संÉयाओं का औसत 

िनकालता है। 

 MIN(): एक सीमा मɅ Ûयूनतम मान खोजता है। 

o उदाहरण: =MIN(LEFT) बाɃ ओर का सबसे छोटा मान खोजता 

है। 

 MAX(): एक सीमा मɅ अिधकतम मान खोजता है। 

o उदाहरण: =MAX(ABOVE) ऊपर का सबसे बड़ा मान देता है। 

7. Security and File Management / सुर¢ा और फ़ाइल Ĥबंधन: 

 Password Protection: Users can set passwords to protect documents 

from unauthorized access. 

(पासवड[ सुर¢ा: उपयोगकता[ दèतावेज़ɉ को अनिधकृत पहँुच से 

सुरǔ¢त रखने के िलए पासवड[ सेट कर सकते हɇ।) 

 Document Recovery: Features to recover unsaved documents in 

case of unexpected shutdowns or crashes. 

(दèतावेज़ पुनĤा[िƯ: अĤ×यािशत बंद होने या Đैश होने कȧ ǔèथित मɅ 

अनसहेजे गए दèतावेज़ɉ को पुनĤा[Ư करने कȧ सुǒवधाएँ।) 
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8. Printing and Exporting / ǒĤंǑटंग और िनया[त: 

 Print Preview: Allows users to see how the document will look 

when printed, with options to adjust settings before printing. 

(ǒĤंट पूवा[वलोकन: उपयोगकता[ओं को यह देखने कȧ अनुमित देता है 

Ǒक दèतावेज़ ǒĤंट होने पर कैसा Ǒदखेगा, ǒĤंǑटंग से पहले सेǑटंÊस 

समायोǔजत करने के ǒवकãप के साथ।) 

 Export to PDF: Users can save documents in PDF format for easier 

sharing and printing without losing formatting. 

(पीडȣएफ मɅ िनया[त: उपयोगकता[ दèतावेज़ɉ को पीडȣएफ फ़ॉमȶट मɅ 

सहेज सकते हɇ, ǔजससे साझा करना और ǒĤंट करना आसान हो जाता 

है ǒबना ĤाǾपण खोए।) 

Common Keyboard Shortcuts in Word 2007 / Word 2007 मɅ सामाÛय 

कȧबोड[ शॉट[कट: 

1. Ctrl + C: Copy / कॉपी करɅ 

2. Ctrl + V: Paste / िचपकाएँ 

3. Ctrl + X: Cut / काटɅ 

4. Ctrl + Z: Undo / पूव[वत करɅ 

5. Ctrl + Y: Redo / पुनः करɅ 

6. Ctrl + B: Bold / बोãड करɅ 
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7. Ctrl + I: Italic / इटैिलक करɅ 

8. Ctrl + U: Underline / अंडरलाइन करɅ 

9. Ctrl + A: Select All / सभी का चयन करɅ 

10. Ctrl + P: Print / ǒĤंट करɅ 

Tips for Effective Use / Ĥभावी उपयोग के िलए ǑटÜस: 

 Customize the Quick Access Toolbar: Add frequently used 

commands to the toolbar for faster access. 

(ǔÈवक एÈसेस टूलबार को कèटमाइज़ करɅ: तेज़ पहँुच के िलए 

सामाÛय Ǿप से उपयोग Ǒकए जाने वाले आदेशɉ को टूलबार मɅ 

जोड़Ʌ।) 

 Use Styles for Consistency: Apply styles to headings and body text 

to maintain a uniform look throughout the document. 

***** 


